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1 The Interface 
1.1 Understanding the interface  
  

When FreeWorship opens you will be able to see the following window. If you are having trouble 

displaying FreeWorship on your projector follow our step by step guide on how to setup your projector 

screen.  

 

The interface is intuitively split into 8 sections as above in red; the function of each section is detailed 

below.  

A. Resource search 
In this section, the user can search through the stored media content, whether that be on the cloud or 

on the machine. The content can then be added to the service list ready for playback. FreeWorship can 

display songs, bible passages, PowerPoints, videos, slide sets, images, a timer and live video feeds or 

a combination of these simultaneously. These features are further explained in The Settings and The 

Basics sections. 

B. Service list  
Here you can see the items in the current service list. This is used to queue items to be displayed 

throughout the service or event; the user can also add notes and headers to aid them whilst displaying 

live. Items can be reordered, removed or added at will. Service list manipulation and use is detailed in 

The Service List. 

C. Transition editor  
The Style Editor allows you to change how Slides transition between each other. Transitions currently 

available include fading, flying and zooming. See Transitions for further information. 

D. Service item display settings  
The middle section of the window shows the service item information. Here you can select which verse 

to display for songs, control a video or select how many bible verses you would like to display. In 

D 
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http://www.freeworship.org.uk/screen-setup
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addition when a Service Item is selected, Style options are available to alter the font and other item 

specific settings.  See Style changes for further information. 

E. Background Editor  
Here the Background of a Service Item can be altered. Currently the background can be a solid colour, 

gradient, an image, or a video. See Individual Service Item Backgrounds for further information. 

F.  Preview window  
The preview window shows you exactly what will appear on the display once you apply it. This means 

you can setup a new Style and change lyrics and see what it will look like before you put anything in 

front of your audience. See Operating FreeWorship for further information. 

G. Apply preview and Display state buttons  
These buttons are the buttons used to control the live output display. The apply preview button will 

apply all the settings and content in the preview window to the live display. The display state buttons 

control the state of the display screen. From left to right they are; to black, to logo, to background and 

show content. Further use is explained in Using the Display State Buttons. 

H. Live window  
The live window shows you exactly what is currently being displayed on the display screen.  

Show Display button 
This button is highlighted yellow on the interface plan; in the top right of the window. Possibly the most 

important button in FreeWorship, enables the user to Show or Hide the live output e.g. to make 

FreeWorship display something or not. The button is a toggle and can also be operated be pressing the 

‘F7’ key. 
 

1.2 Adjusting the interface 
The interface in FreeWorship can be adjusted to suit each operator’s needs by resizing or minimising.

 
 

This process will be familiar to the Windows user. By hovering over any of the borders highlighted in red, 

the double headed arrow will appear, allowing the user to drag the border, thus resizing the section. In 
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addition, the Transitions and Background sections may be minimised by clicking the arrow to the right of 

the heading; also highlighted above. FreeWorship will initialise to the previously used layout.  

 

The user can also quickly adjust the colour scheme or language of the FreeWorship interface. Click Settings 

in the top left of the main window to open the drop-down below.  

 
By hovering over the Skin or Language options, a further menu will open to the right. By selecting another 

Skin, the colours of the headings, borders, and for some options the section backgrounds will change. A 

particularly useful option is Dark which will work well in an environment with low ambient lighting e.g. a 

candlelit church service.  

  



7 
 

2 The Settings 
Before starting to use FreeWorship, it is recommended to check the display settings are configured for 

your environment. A majority of the useful settings are accessed through Settings > Preferences. 
Alternatively, Ctrl+P will also open the preferences window.  

 
 

2.1 General 
In the general settings window, 3 main settings can be adjusted; the language, the default Basher and 

the logo. Use of the Basher and logo are explained in Using the Bashers and Using the Display State 

Buttons repectively.

 
 

2.1.1 Language 
The language can be simply selected from the drop-down menu as highlighted above. Note, this will 

change the language of the interface and menus of FreeWorship, but will not affect the songs database 

or any other media that may be associated.  

 

2.1.2 Bashers 
The Basher is a live output tool which enables the user to quickly display an item. This may be a 

spontaneous addition to the service or something that was simply missed in the first place. In 

FreeWorship, you can use the Basher to display a bible verse, a slide, an alert or a message to the stage 

display. The default setting affects which Basher will be accessed when pressing the arrow to the right 

of then display state buttons, highlighted in red above. In any case, the other Bashers can be accessed 

via the keyboard shortcuts listed below: 
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Bible Basher CTRL+1 

Slide Basher CTRL+2 

Alert Basher CTRL+3 

Stage Basher CTRL+4 

 

2.1.3 Logo 
The logo is displayed by FreeWorship when the Show logo display state button is pressed (See Using the 

Display State Buttons). The default is the FreeWorship logo, however, it can be changed to any picture 

that is stored on your machine or server. Simply navigate to the picture file by typing the file path into 

the file browser, or navigate to it by clicking on folders, as you would in the Windows environment.  

 

2.1.4 Other 
Two other settings are accessed here: 

 Preview on mouse over/ single-click, affects the Service item display settings section of the 

interface. If the mouse is moved over a verse of a song, for example, when checked, FreeWorship 

will place this verse in the preview window ready to go live. This enables quick on-the-fly 

adjustments to song arrangements. 
 Select next item on apply, affects Progressing an item. 

 

2.2 Display  
The Display settings dialog allows the user to adjust the main output display settings.  

 

 

2.2.1 Display Setup 
This setting allows the user to adjust the size/resolution of the output display. A quick setting for full-

screen is located at the top, however, the user can adjust the output by resizing or moving the grey box. 

This be done by clicking and dragging one of the four corners or the centre of the box. Alternatively, 

exact values can also be adjusted by typing in the labelled boxes: Left and Top adjust the position and 

Width and Height, the size.  

 

2.2.2 Margins 
Margins adjust the area which FreeWorship will display on the output. When the screen size has been 

set, the user may wish to leave a small border around the displayed content which can be achieved by 

adjusting the percentage values to each side of the lower grey rectangle, or by dragging a corner.  
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2.2.3 Transitions 
 Display transition: the time it takes for FreeWorship transition to live output. Drag the slider left 

or right to make the fade transition shorter or longer respectively. This setting only affects the 

Show/Hide toggle button and the F7 shortcut. 

 Layer transition: the time it takes for FreeWorship to transition when a Display state button is 

pressed. Drag the slider left or right to make the fade transition shorter or longer respectively. 

This setting affects the content and background layers as well as the logo. 

2.3 Stage 
The Stage settings dialog enables the user to adjust the display settings for the stage display. 

 

 

2.3.1 Stage Display Setup and Margins 
Here the size of the stage display and the content margins can be adjusted in the same manner as the 

main display. 

 

2.3.2 Stage Display adjustments 
The two sliders highlighted in the dialog above adjust the display elements of the stage display output.  

 

 
 

 Title Space (Top) adjusts the sizing of the upper highlighted section of the display. This includes 

the title of the current display item. Slide right to increase the size of this element or left to 

decrease the size. 

 Next Slide Space (Right) adjust the sizing of the highlighted section to the right of the display. 

This includes the next display item, which mirrors the operator’s Preview Window. 
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The clock and the current display item sections will automatically resize to fill the screen area as set 

in Stage Display Setup and Margins. 

 

2.4 Songs 
The Songs settings dialog enables the user to change the default Style for any songs that are added to 

or are in the service list. The settings can also be adjusted on a song by song basis as shown in Style 

changes. 

 

 

2.4.1 Style 
The Style settings adjusts the text for song service items. The font, size and colour can all be easily 

adjusted here.  

 

 
Additional settings can be accessed by clicking the Extra button. By checking one of the options, the 

respective name will be displayed on the live output screen. For example, if Verse name is checked, the 

text Verse 1 or similar would be displayed above the main body of the text on the first slide. The final 

option, when checked, simply capitalises any of the displayed names.  

 

2.4.2 Background 
Here the default background for songs can be set. In FreeWorship, a colour or gradient, image or video 

feed can be displayed behind the text of a song. Select one of the highlighted buttons on the left hand 

side of the dialog to change between the three media types respectively. To select an image or feed, 

simply browse using the file browser. There are options to adjust the scaling of the image here too e.g. 

whether a small image should maintain the size or should be stretched to fill the whole screen.  

 

To use a solid colour or gradient, select one of the three grayscale squares with the desired effect. The 

two colours (if needed) can then be selected by clicking on the two coloured squares. By clicking on the 

coloured preview, the red and green pins, highlighted above on the main Songs Settings graphic will 

move, adjusting the gradient pattern and mixing the two selected colours together.  
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2.4.3 Quick edit save 
This checkbox, highlighted to the bottom of the dialog, affects the Quick Edit feature, discussed further 

in Using Quick Edit. By checking this box, any Quick Edits that are made to a song will automatically be 

saved to the song in the database, ensuring no errors in future uses of the song. 

 

2.5 License 
The license settings allow the user to enter a CCLI number or adjust the formatting of the license display. 

This information can be displayed at the foot if selected. Further information is available in this dialog via 

the Help button. The Default button will get you back to something useful if it all goes wrong. 

 

2.6 Bibles  
The Bibles dialog, enables the user to change default appearance settings for displaying bible passages. 

The background and foreground display settings can be adjusted in the same manner as songs; see 

section 2.4. 

 

 

2.6.1 Bible specific settings 
Additional settings for the bible can be adjsuted here. By clicking Extra, a drop-down menu opens as 

below. In the menu, the default bible can be changed to any of the installed bibles, see section 5 for 

bible installation. FreeWorship by default displays the bible passage and version name in the bottom 

right corner of the main output; this can be toggled on or off, the format changed and the position 

adjusted.  
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The Default Number of Verses Selected setting, highlighted in red at the bottom of the dialog, adjusts 

how the bible passage will be displayed. By default, FreeWorship will display 3 verses from a passage; 

this can be adjusted on-the-fly (see section 4.8). Simply slide left or right to decrease or increase the 

number of verses that will be displayed.  

 

2.7 Slides and Timers 
The Slides and Timers dialogs allow the user to adjust the default display settings for slides and timers 

respectively; this is done in the same manner as songs and bibles. See section 2.4 for details. 

 

2.8 Performance 
The performance dialog only has a single setting; Video Preview Level. This slider allows the user to 

adjust the number of video previews within FreeWorship. The default is Show video in presentation, live 
and preview. With this setting, a video preview will be shown in the Preview window, the Live Window 
and also the main presentation output of FreeWorship; see section 1.1 for clarification. By sliding left, 

the user can reduce the number of video instances; slide once to remove the Preview Window instance 

and fully left to remove the live window instance also, leaving only the main presentation output. 

 
Where possible it is recommended to keep the default setting as it allow the user to easily understand 

what FreeWorship is displaying and will display next. This setting should be adjusted, however, if the 

system that FreeWorship is running on is unable to smoothly playback a video on the main output. 

Reducing the number of video instances reduces the load on the CPU and should increase the quality of 

the video playback on the main presentation.  
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3 The Basics 
3.1 Creating a song  
Possibly the most important process to learn in FreeWorship is how to create a song. To start navigate 

to Tools > Create Song. 

 
The dialog below will open which is the starting point to creating a song in FreeWorship. 

 

 
There are two option tabs at the top; Basic info or Advanced Info.  

 

Ensure after any changes to the song are finished to click Save. This will save the changes to the song 

in the service list and into the database. Click Cancel to discard any changes.  

 

3.1.1 Basic Info tab 
The Basic info tab allows the user to input the main body of the song and adjust the order it may be 

displayed in. The title/s and author/s can also be set. To add an additional title or author as has been 

done below, simply click on the highlighted plus symbol to the right of the label. This will create another 

editable field to enter a secondary title/author. This is particularly useful for songs which may be known 

by multiple titles. In the example below, How great is our God can also be known as The Splendour of 
the King. By including both titles, it will make the FreeWorship search function easier; a user can search 

for either title and still find the song. This applies to authors as well. Remove a title or author field by 

clicking the minus symbol, highlighted to the right. You can also change the type of Author by clicking 

on General to the right of the editable Author fields, to open a drop down. This, with the options is shown 

below. 
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3.1.2 Inputting the lyrics 
In FreeWorship this couldn’t be simpler. In the lyrics section, highlighted red below, simply enter the text 

of the song; you can type the lyrics out or simply copy and paste. The window opens with a default 

Verse label; just click the cursor below that and enter the lyrics. Every time a blank line is left, 

FreeWorship will place the next block of text on a new slide. So in the example below, The Splendour of 
the King… and He wraps himself in light… will appear on different slides with the accompanying lyrics 

below them.  

 

 
To add another section of the song, in FreeWorship, simply type the name of the new section. This can 

be Verse, Chorus, Bridge or Ending. Leave at least one line from the previous heading and on a new line 

type the new header. If there has previously been a section with the same heading, FreeWorship will 

increment the number of the new heading; for example Verse 2 will be displayed next time Verse is 
typed. The new section will have a different colour to easily identify each one. An example with all the 

section headings and their colours is shown below.  

 

Some operators may wish to have multiple instances of a chorus for example so they can simply use 

click through the song without jumping around sections whilst live. To repeat an already entered item, 

simply preceed the section name with Repeat eg. Repeat Chorus. This acts in the same way as the other 
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sections and will auto-complete. Any section can be repeated, but it should be noted that only the 

heading is shown in the Edit Song dialog, without the repeated text. 

 
 

 

 

 

 

 

 

 

 

 

3.1.3 Advanced Info tab 
The Advanced Info tab allows the user to enter further information regarding the song. Fields such as 

Publisher, Copyright and CCLI No. are displayed on the main output n the bottom right. Leave these 

blank if this is unwanted or not needed. Other fields are visible in the database and can be used to search 

or to differentiate song variations.  
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3.1.4 The finished song 
If creating a new song, the song will automatically appear in the service list and in the Service Item 
Display Settings as below. The different setions are clearly visible with the entered headers, and the 

individual slides are also distinct and numbered.  

 
 

3.2 Creating a Slide Set 
In FreeWorship, the user can create Slides and Slide Sets. The slides are essentially the main output 

screen at one moment in time, onto which the user can put content such as text or an image. Multiple 

Slides can then be used together to create a Slide Set which is essentially a presentation similar to 

PowerPoint, just in a more efficient format for FreeWorship. These Slide Sets are subsequently stored in 

the FreeWorship database on the system.  

 

3.2.1 Creating a Slide Set 
To create a Slide Set, first in the Resource Search section of the interface, identified in 1.1 click on the 

Slide Set symbol as highlighted red below.  

 

 
 

When Slide Sets have been created, they will be visible in this section. To create a new set, click on the 

Slide Set symbol with a plus to the right of the section, highlighted in red above. This will open the Slide 
Set editor in the Service Item Display Settings as shown below. The default can be set as described in 

section 2.7. 
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The Slide Set controls are at the top of the section. From left to right they are: 

 Move up and Move down moves a selected slide up or down the order respectively. 

 Add Slide adds a blank slide to the Slide Set. 
 Add image adds an image slide to the Slide Set. It opens an explorer window to navigate to the 

file. 

 Loop is a toggle. When depressed, the button will be filled with colour signifying that the Slide 
Set will repeat when live. Otherwise the Slide Set will simply play through once.  

 

The Style settings for the slide can be adjusted in the same way as in section 2.7. The background 

settings are located in the Background Editor Interface section identified in 1.1. 

 

Text can be added to a Slide by right-clicking to the right of the Slide preview, highlighted below in red.  

 

 
The editable field then opens to allow the user to type the desired text which will review immediately to 

the Slide and in the Preview Window. By right-clicking on the 12s, the transition time can be edited in 

seconds for each slide by changing the time as below. This is the amount of time each slide will be 

displayed for. 

 

 
 

The Slide Set is automatically saved to the database with the date as the default name. The name can 

be changed by right-clicking on the Slide Set in the Service List as shown below. The name becomes an 

editable field and will update the database entry as well.  

 

 
  



18 
 

The saved Slide Sets are then visible in the Resource Search section as below.  

 
 

The Slide Sets can be deleted or sorted by using the controls to the left of the section as highlighted 

above.  

 

Adding a Slide Set is explained in 3.4.5. 
 

3.3 The Service List 
The Service List is essentially a service plan for the visuals operator. It includes all of the content that 

will be displayed throughout the service/event, in the order that it will be displayed in. FreeWorship 

automatically increments through the Service List on finishing the current item. Alternatively, the user 

can simply click on an item to move this into the Service Item Display Settings section and onto the 

Preview Window.  

 

3.3.1 Creating a Service List 
To create a new Service List simply navigate File > New Service List or alternatively use the shortcut 

CTRL+N.  

 
If the current Service List hasn’t been saved, a dialog will appear to save or discard the current Service 
List before a new blank one is created. 

 

 

3.3.2 Saving a Service List 
To save a Service List simply navigate File > Save Service List or alternatively use the shortcut CTRL+S.  
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Alternatively, if a Service List has been edited and a new version should be saved, use the Save Service 
List As or CTRL+SHIFT+S to save with a new name.  

 

3.3.3 Opening a Service List 
To open an already created and saved Service List navigate File > Open Service List or alternatively use 

shortcut CTRL+O. Any FreeWorship service list can be opened whether it has been created on the 

machine or on another machine. Note that any media that is referenced in the Service list, must be on 

the system that is being used and in the same file location.  

 
 

3.3.4 Service List Controls 
At the top of the Service List are five controls to enable the user to adjust the Service List. 
 

 
From left to right: 

 The Edit Item button allows the user to edit a song. Simply select the song in the Service List 
and click the button to open the song editor. Follow the instruction in section 3.1 to edit the 

song.  

 The Add Header button allows the user to add a Header to the Service List. These may be used 

to split the Service List into sections as shown below. These are simply labels for the benefit of 

the user and do not affect the operation of the Service List or any other element. 

 

 
   The Move Up and Move Down buttons allow the user to reorder the Service List. Simply select 

an item and click one of the buttons to move that item up or down the order respectively. 

Alternatively, this operation can be achieved by clicking and dragging an item to a new position.  

 The Remove from Service button allows the user to remove the Service Item from the Service 
List. Simply select an item and click the button to remove it from the list.  

 

3.3.5 Right-Click 
By right-clicking on a service item, further options are available for Service List manipulation. A 

particularly noteworthy function is the Edit Service Note button which allows the user to add a note to 

the item in the Service List as shown below. 
 



20 
 

 
Simply type the desired note in the editable field and click off the item or press the enter key to save the 

note. 

 
 

3.4 Adding an Item to the Service List 

3.4.1 Songs 
FreeWorship stores songs in a database stored on the system; more information on the database can be 

found in Database Management. In the Resource Search interface section, the user can browse the 

database and add a song to the Service List. First click on the song symbol, as highlighted below, to 

bring up the song search.  

 
 

By typing in the highlighted search box, FreeWorship will search the database using the letters, matching 

against song titles. Hence it is important when creating songs to use as many alternative titles as possible 

as described in 3.1.1. Consequently, the likelihood of any user finding the correct song quickly, will be 

increased. Simply press the Enter key or double click on the highlighted song title to add it to the Service 
List. 
 

3.4.2 Bibles 
FreeWorship by default comes with two bibles; the King James version and the American Standard 

version. To add more bibles to FreeWorship, take a look at the download page on the FreeWorship 

website. (https://www.freeworship.org.uk/links) To add a passage to the Service List, first click the bible 

symbol as highlighted below.   

 

 
The bible search function uses an autocomplete to allow the user to quickly navigate through the bible. 

The format is “Book Chapter:Verse – Verse”  e.g. John 1:1 – 10. As the user types, FreeWorship will 

begin to autocomplete based on the letters already typed; when the desired value is displayed, press 

the Right arrow key to move onto the next element. Use the Left arrow key to move back along the 

phrase to adjust the elements. Press Enter to add the bible passage to the Service List.  
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3.4.3 PowerPoints 
To add a PowerPoint to the Service List, press the PowerPoint symbol in the Resource Search section as 

highlighted below. Then use the file browser in the Service Item Display Settings section to navigate to 

the file, double clicking to add it to the Service List. Alternatively, type the file path to navigate directly 

to the file. FreeWorship uses the PowerPoint application itself to play these files, so specific formatting 

will be retained for playback. 

 

 
 

3.4.4 Videos 
Videos can be added by two means; a locally stored file or by URL, primarily aimed at YouTube. Currently 

the URL option is experimental.  

 

3.4.4.1 Local files  
Click the video symbol, highlighted below in red, in the Resource Search to open the video file browser 

in the Service Item Display Settings. 
 
In the subsequent file browser, navigate to the video file or enter the file path. Ensure the folder icon to 

the left of the browser, highlighted below in red, is filled with colour. If not, click the folder icon.  

 

Browser controls are highlighted in yellow; the arrow symbol on the left allows the user to navigate back 

up the folder tree in the file browser, whilst the slider on the right, adjusts the size of the icons in the 

browser. Slide to the right to increase the size, left to decrease. All features of the file explorer are 

common to the Windows environment.  
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In the Service Item Display Settings section, FreeWorship includes some playback control of the video. 

In addition to the intuitive controls to preview the video, the user can adjust the playback length, the 

starting point and the ending point of the video. 

 

 
 

This is achieved by dragging the arrows, highlighted red above, from right to left. The left hand arrow 

adjusts where the video will start, and the right hand arrow where it will end.   

 

3.4.4.2 Video by URL 
Coming Soon! 

 

3.4.5 Slide Sets 
In FreeWorship, the user can create and use Slide Sets as part of a service. Creating Slide Sets is 

explained in 3.2 .To add a Slide Set to the Service List from the database, first click the Slide Sets icon 

in the Resource Search section identified in 1.1. 

 

 
By double clicking on one of the stored Slide Sets, the item will be added to the Service List. 

 

3.4.6 Images 
Images can be added to the Service List in the same manner as videos. First click the Images icon in the 

Resources Search section identified in 1.1 and highlighted red below. Then follow the file browser 

instructions in section 3.4.4.1 as explained for videos.  
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In addition, in the Service Item Display Settings section FreeWorship includes settings to adjust the 

position and scaling of the image on the output. The controls are highlighted in red above. From left to 

right these are: 

 

 Center retains the size of the image about the center of the output screen. 

 Crop To Fill fills the full width of the screen, cropping the top and bottom of the image. The 

proportions of the image are retained. 

 Scale To Fit fills the full height of the screen, leaving blank space to either side of the image. 

The proportions of the image are retained and none of the image is lost. 

 Stretch To Fill matches the size of the image to the size of the screen, to fill the screen entirely. 

The proportions of the image are not retained and can lead to distortion. 

 Custom allows the user to manipulate the image using the grey square, highlighted in red above. 

The user can drag the corners of the square to change the size and scaling of the image and by 

clicking and dragging on the center of the square, the position of the image can be changed. 

FreeWorship will allow the image to be set outside of the confines of the output to allow parts 

of the image to be cropped.  

 

3.4.7 Timers 
In FreeWorship, Timers can be added as a Service Item. To configure and add a Timer to the Service 
List, first click the Timers icon in the Resource Search section identified in 1.1 and highlighted in red 

below. 

 

 
 

The Style and Background of the Timer can be adjusted in the Service Item Display Setting Section as 

described in 4.5 and 4.6. There are four display options in the Timer sections: 

 

A. Digital Clock displays the current system time, in a digital clock style. ‘hh:mm:ss’ 

B. Analogue Clock displays the current system time, using an analogue clock face. 

C. Digital Timer can be used as a timer which can be set using the controls below the clock faces. 

Set a start and end time using the arrows or by clicking and then typing on an individual element 

to adjust it. Again the format is ‘hh:mm:ss’. Note the timer in the preview should be used for 

Style reference only. The main output is independent and will restart from the set start time 

when the preview is applied to the Live Window. The timer will also continue whilst the Display 
State buttons are depressed. 

D. Analogue Timer operates in the same manner as the Digital Timer, however, with an analogue 

clock face.  

 

A B 

C D 
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Upon clicking the Timer icon, a Timer Service Item is automatically added to the Service List. Any 

adjustments to the settings will automatically save to the Service List.  
 

3.4.8 Video Stream 
In FreeWorship, the user can add a live Video Stream to the Service List as a Service Item. First click the 

Video Stream icon in the Resource Search section identified in 1.1 and highlighted in red below. 

FreeWorship automatically detects any connected video hardware such as a webcam or capture card, 

and displays the available streams in the Service Item Display Settings section.  

 

 
 

Controls to adjust the scaling of the image are located at the top of the section as highlighted above. 

When the Video Stream icon is pressed, a Video Stream Service Item is automatically added to the 

Service List. Simply select one of the available streams and scaling options.  

  

Stream 
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4 Operating FreeWorship 
With a loaded Service List, see 3.3 if this is not the case, and the display settings fully configured, see 

section 2 if this is not the case, FreeWorship is ready to operate. Follow the steps below to display a 

service. 

 

4.1 Take control of the display 
The first step to display with FreeWorship is to take control of the output. You should already be 

connected to the projector; see the instruction on the FreeWorship website if this isn’t the case. 

(https://www.freeworship.org.uk/screen-setup). 

 

Click the Show Display button in the top right of the FreeWorship window. Alternatively, use F7. 

 

 

 
 

 

4.2 Displaying a Service Item 
To display a Service Item on the main output in FreeWorship, firstly click on the item in the Service list 
to highlight it. In this case demonstrated with a Song Item. 
 

 

 
This step will move the Song Item into the Service Item Display Settings section of the interface as 

identified in 1.1. 

 

Ensure you have completed the step in 4.1 and the Show/Hide Display button is as below.  

 

 
 

The screen should appear as below. The first slide in the song is highlighted and visible on the Preview 
Window. At this point, nothing is shown on the main output, illustrated by the blank Live Window. 

https://www.freeworship.org.uk/screen-setup
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To display the slide in the preview, simply press the Apply Preview button located below the Preview 
Window, and highlighted below.  

 

 
 

Alternatively, the user can use CTRL+DOWN to apply the preview to the main output. Now, as shown 

above, the slide on the Preview Window is transferred onto the Live Window and onto the main output. 

 

Note a light highlight colour in FreeWorship signifies the slide is in the Preview Window, and a dark 

highlight colour signifies the slide is live and on the main output. Hence, the slide that is now on the 

main output, is highlighted with a darker colour, with the next slide highlighted in the lighter colour as 

before. This slide is now also visible in the Preview Window.  
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4.2.1 Progressing an item 
In FreeWorship there are three main ways to display a new slide on the main output: 

 

 PgUP and PgDN buttons can be used with FreeWorship to move up and down the slides. By 

pressing either button, both highlighted slides, the preview and the live increment together. 

From the starting position, after pressing PgDN, the screen would appear as below. No other 

buttons need to be pressed to change the main output. Note that at the end or beginning of 

an item, PgDN or PgUP will move to the next Service Item in the Service List respectively, 

hence a whole service can be operated using only these buttons. 

 

 
 

 Moving the preview highlighting and clicking or pressing Enter. The user can move the cursor 

over another slide in the Service Item Display Settings interface section as identified in 1.1 ; this 

can also be achieved using the UP and DOWN arrows. By using the arrow keys, the Preview 
Window will update when a different slide is highlighted. If using the mouse, it depends on the 

Preview on mouse over / Single click setting as described in 2.1.4; if checked the Preview Window 
will change whenever the preview highlighting is moved to another slide. Otherwise, a single 

click is required to move the desired slide to the Preview Window. 
 

To move the preview to the main output either press the Enter button, or depending on the 

setting mentioned above, a single or double click will change the main output. 

 A slight variation on the method above uses the Apply Preview button instead of Enter to change 

the main output. The preview can be changed as above. 

 

4.2.2 Using a presenter 
FreeWorship accepts an input from a presenter controller. These controllers act as the PgUP and PgDN 

buttons. Compatible controllers will require no further adjustments to function in FreeWorship. 

4.2.3 Using the Display State Buttons 
In Freeworship, the display state buttons allow the user to alter the main output. These are located 

between the Preview Window and Live Window. 

 

 
 

Lighter 

Darker 
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From left to right these are: 

 

 To Black makes the output screen black, effectively removing all content from the output. The 

content that was previously on the output is retained essentially below the black, hence by 

pressing the Show Content button as described below, the content can be returned to the main 

output. The Live Window (left) and main output (right) will appear as below: 

 

 
 

The function can also be performed using F9. 
 
 To Logo places the logo set in the Settings dialog, as described in 2.1.3. In the same way as To 

Black, the content is retained below and the Show Content button returns it to the screen. The 

Live Window (left) and main output (right) will appear as below: 

 

 
 

The function can also be performed using F10. 
 

 To Background removes any text layers from the main output, leaving only the background 

displayed. The text can be returned to the screen by pressing the Show Content button. The 

Live Window (left) and main output (right) will appear as below: 

 

 
 

The function can also be performed using F11. 
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 Show Content overrides any of the previously depressed Display State buttons and returns all 

content to the screen. The Live Window (left) and main output (right) will appear as below: 

 

 
This function can also be performed using F12. 
 

4.3 Using the Bashers  
In Freeworship, there are four Bashers which can be used to quickly add to the main output screen. To 

set the default basher see section 2.1.2. The default basher can then be opened by pressing the arrow 

to the right of the Display State Buttons as highlighted in red below.  

 

 
 

This opens the default Basher with an editable field and a button to the right to hide the basher, both of 

which are highlighted in red below. 

 

 
 

Any Basher can be accessed at any time via a keyboard shortcut, and can be minimised in the same way 

as above. Once a different Bahser has been used, this will be the default Basher for the rest of the 

FreeWorship session. A description of each Basher ‘s use and the respective shortcuts are below.  

 

 Bible Basher can be accessed via CTRL+1. This enables the user to quickly place a bible passage 

on the screen. The Style of the display is set by the default as described in 2.6. How to enter a 

bible passage into the editable field is described in 3.4.2. Press enter after typing to place the 

desired passage on the screen. The passage will replace any content currently on the screen and 

can be removed by applying the preview to the main output.  

 

 Slide Basher can be accessed via CTRL+2. This enables the user to quickly place a Slide on the 

screen. The Style of the Slide is set by the default as described in 2.7. The editable field allows 

the user to place text on the Slide. Press enter to place the desired Slide with text on the screen. 

The Slide will replace and content currently on the screen and can be removed by applying the 

preview to then main output. An example of using the Slide Basher is below.  
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 Alert Basher can be accessed via CTRL+3. This enables the user to quickly place an Alert on the 

screen. An Alert is a scrolling piece of text along the bottom of the screen. Multiple Alerts can be 

added simultaneously and will appear one after the other. The Alert will cycle only once. Type in 

the editable field and then press Enter to place the Alert on the screen. Multiple instances of the 

same text can be created by simply pressing Enter the desired amount of times. An example of 

using the Alert Basher is below. 

 

 
 

 Stage Basher can be accessed via CTRL+4. The Stage Basher functions in the same way as the 

Alert Basher, however, is not visible on the main output screen; it is visible on the Stage Display. 

See above for description of use. An example of using the Stage Basher is below, the Stage 
Display output shown on the right.  
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4.4 Using Quick Edit 
Quick Edit is a feature in FreeWorship which allows the user to edit a Song Item without needing to open 

the full Edit Song dialog. The functionality of this feature depends on the Save Song after Quick Edit 
setting as described in 2.4.3. If checked any alterations will be saved to the song in the database, 

otherwise they will be discarded after the session. The output is unaffected whilst Quick Edit is being 

used, hence if a spelling mistake or grammar error is spotted, the operator can quickly adjust the Slide 

before it is displayed whilst live! Furthermore, should the operator decide the Slide has too much text on 

it, the operator can, by pressing the Enter key, insert a blank line. This causes FreeWorship to create an 

extra Slide to split the current Slide into two.  

 

 
 

By right clicking on any slide in the Service Item Display Settings section as identified in 1.1, the slide 

text becomes an editable field which can be adjusted by the user. Simply type the amendment and move 

the cursor away or click on another slide to store the change; this depends on the Preview on mouse 
over/ single-click, described in 2.1.4. As a minimum the change is stored for the rest of the session.  

 

4.5 Style changes 
In Freeworship, the user can alter the style of a Service Item in a Service List. The Style settings can 

be accessed in the Service Item Display Setting section identified in 1.1. Select an item in the Service 
List and then click Edit, as highlighted in red below.  

 



32 
 

 
This will open the Style settings for that item, as shown below. These can be edited in the way described 

in 2.4.  

 

 
 

In the top right of the settings, three additional options exist, highlighted in red above. From left to right 

these are: 

 

 Save As Default will store the adjustments in the Style settings as the new default for 

FreeWorship. This will affect any additional Service Items added to the Service List, however, 

will not affect any items currently in the Service List.  
 Apply To All will store the adjustments in the Style settings to all items in the Service List. 
 Clear will remove any adjustments made to the Style and restore the default to the Service Item. 

 

4.6 Individual Service Item Backgrounds 
In FreeWorship, the user can change the Background of each individual Service Item. Unlike Style 

changes, these cannot be more widely applied, however, they are stored with the Service Item in the 

Service List. The alterations that are made will be stored to the Service List when it is saved. This allows 

the user to program a service during the week and simply load a plan on a Sunday for example, without 

needing to change the Backgounds again. Note, any media used as a Background e.g. an image, will 

need to be available in the same file location every time for FreeWorship to be able to use it. To edit a 

Background, ensure a Service Item is selected and the Background Editor is maximised as described in 

1.2. Then follow the instructions in 2.4.2 to change the Background settings.  

 

4.7 Transitions 
In Freeworship, unlike other display options, Transitions cannot be attributed to a Service Item. Select a 

transition for all Slides in a service, or change the Transition on the fly. The Transitions will be familiar 

to any user with experience of PowerPoint. It is possible to change the length of the Transition in addition 
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to the type by typing in the editable field highlighted in red below. Otherwise, hover the cursor over a 

Transition for a description and simply click on a Transition to apply it to the service. 

 

 
 

4.8 Bible Specific 
In FreeWorship there are a number of bible specific Display Settings. The number of verses that are 

displayed on a Slide can be selected by the user in the Service Item Display Settings section as 

identified in 1.1. Setting the default is described in 2.6.1. To increase or decrease the number of verses 

displayed, simply click on the first verse, and holding the Shift key, click on the verse that corresponds 

to the desired number. In the example below, the default is set to three, and the user is setting the 

display number to 8. 
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As can be seen above, now eight verses are highlighted. FreeWorship will now step through the passage 

in steps of eight verses, creating a slide from each section automatically. The number of selected verse 

reverts to the default once another Service Item is selected. Use the usual methods to progress through 

the passage as described in 4.2.1. 

 

Additionally, the user can increase or decrease the length of the passage that is displayed without using 

the Resource Search. In the Service Item Display Settings, there are an arrow at the top and bottom of 

the passage, highlighted in red above. By clicking on one of the arrows, the passage will increase or 

decrease by one verse; this will not continue beyond the end of the chapter. The Service Item will update 

accordingly.  
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5 Importing 
Migrating from another presentation can often be a daunting prospect; with FreeWorship, this is not the 

case. The Import funtion, allows a user to import songs from many of the other popular presentation 

softwares available. These are shown below. Navigate File > Import > Song. 
 

 
 

The importer dialog, shown below, will open, allowing the user to select the software from which they 

are importing. A file browser window will then open allowing the user to navigate to the storage 

location of the song/s that are required.  

 
 

FreeWorship will automatically convert the song/s into the correct format for the FreeWorship database, 

allowing them to be immediately added to a Service List or to be used at a later date.  

  



36 
 

6 Database Management 
The FreeWorship database is stored locally on the system. A majority of the time, a user will never need 

to access the database, as it manages itself as the user creates new songs or Slide Sets etc. However, 

FreeWorship includes a database manager, to allow the user to manually browse, edit or change the 

location of the database. To open the database manager navigate Tools > Manage Database as shown 

below.  

 

 
 

The following window will open: 

 

 

 
 

There are several controls in each tab which are intuitive to the user.  

 

 
 

In the Songs tab, the user can do use the controls shown above, but described below from left to right: 
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 Edit Item allows the user to edit the song by opening the Song Editor dialog, use of which is 

described in 3.1.  

 Add Item allows the user to create a new song and add it to the database using the Song Editor, 
described in. 

 Delete Item allows the user to permanently remove a song from the database. Simply select an 

item and click the button. 

 Import Item allows the user to import a song from another presentation software. The button 

opens the Song Importer window, described in 5. 

 

To the right of the controls is a search box, highlighted in red above, allowing the user to search the 

database for a specific song they wish to view the information of or edit. 

 

In the Bibles tab, the user can once again view the installed bibles, delete a bible or import another bible. 

Using the symbols described above. In addition, a Set as Default option exists, to set a bible as the 

default bible that FreeWorship will use.  

 

In any of the tabs, the database can be sorted by clicking on any of the database field names; this cause 

the results to sort in ascending or descending order based on that data. These field names are highlighted 

yellow above. 

 

The location of the database on the system is shown at the top of the database manager, and shown in 

the graphic below.  

 

 
 

The location can be viewed in Explorer by clicking the Open In Explorer button.  

 

The user also has the option to change the storage location of the database by clicking the Change 
button. This opens an Explorer window. The user can navigate to the desired new storage folder and 

FreeWorship will migrate the database to the new location. The user can revert back to the default 

location, simply by clicking the Default button.  
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7 Troubleshooting  
  
7.1  There is no output…  

  

Ensure the Show Display toggle button in the top right is pressed, F7. Ensure the Show Content 
button is selected, F12. Ensure the Apply Preview button has been pressed to move content 

from the Preview Window to the Live Window and the main output.   
  

7.2  The Main Output is on the wrong screen…  
  

Attempt to move the mouse to the right onto the desired screen; if this is successful 

continue.   

  

Along the top bar next to the Show/Hide Display button, click the drop down arrow. Then click 

Presentation Display. This will bring up the available displays on which to put the Live Output. 

If \\.\DISPLAY1 is selected, instead select \\.\DISPLAY2 etc. The process is shown below. 

  

 

 
  

7.3 PowerPoint is not functioning…  
  

Close FreeWorship. Ensure that the PowerPoint application is closed; if necessary open the task 

manager using the CTRL+SHIFT+ESC key combination. Search for POWERPOINT.exe in the 

process list and end the process. Restart FreeWorship and it should function again.   
 


